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Getting familiar with
your color server



System overview
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Turning your color
server on and off



Turning on the CX print server

Start > CX700 > CX700

Turning off the CX print server

File Exit

Yes

Shut Down OK



Setting up your color
server



Defining color server settings

Setting localization options

File Preferences

Localization

Units

Language

Save



Changing the server name
Server Setup

File Preferences.

Server name Change.



Computer Name Change

Computer name

Workgroup Domain

OK

OK

● No
● Yes

Changing IPX printing settings



File Preferences.

Network Setup.

IPX printing Tree Change



Frame type
OK

OK

● No

● Yes

Changing the TCP/IP setup

File Preferences.



Network Setup.

TCP/IP Change

● Obtain an IP address automatically
● Use the following IP address



192.168.62.1

255.255.255.0

OK

OK

● No

● Yes

Changing IPv6 settings

File Preferences.

Network Setup.

IPv6 IPv6

Save

Changing AppleTalk settings
®

File Preferences.



Network Setup.

AppleTalk setup Change

OK

OK



Save.

Changing password settings

File Preferences.

Security

Passwords area Auto log on

Auto log on

Administrator

Enter old password
Enter new password



Verify new password
Apply

Operator

Disable guest connection

Auto log on

Save

Setting the Disk Wipe option

File Preferences



Security

Disk wipe

● Wipe disk on system
shutdown 

● Wipe disk on system
shutdown 

Save

Setting calibration options

File Preferences.



Calibration and Color

Calibration Device

● Calibration is done off-the-glass

● Calibration is done using device tool

Calibration reminder Set calibration
reminder every (hours)

calibration reminder



Setting up a virtual printer

Virtual printers

●

●

●

Adding a virtual printer



Printer Default 

Tools Resource Center

Resource Virtual Printers

Add

Name

Based on

 Publish on the network



Override PPD parameters

Comments

Edit 

OK

Editing a virtual printer's settings

Tools Resource Center

Resource Virtual Printers



Edit

Edit

OK

Removing a virtual printer

Tools Resource Center



Resource Virtual Printers

Delete

Yes.

Maintaining your settings

Backing up the configuration

File Preferences.



Preferences Configuration Backup

Configuration backup Browse

Save

Configuration backup Start Backup

C:\CX700\General\Configuration

Restoring the configuration



.cnf

File Preferences.

Preferences Configuration Backup

Restore configuration Browse

Open

Start Restore



OK





Setting up your client
workstation



Setting up your Windows client workstation

Add a virtual printer to your Windows client workstation

●

●

Using the Windows Add Printer Wizard to define a virtual
printer

Start Settings Printers and Faxes

Next

Printer Tasks Add a printer



A network printer, or a printer attached to another
computer Next

Browse for a printer Next

Next

● Yes

● No

Next

Finish

PPD

Using the network neighborhood to define a virtual printer

®

Start Run

Open \\

OK

PPD



Deactivating the Print Driver software

PPD

Start Settings > Printers and
Faxes

Properties

Print Driver

Enable enhanced user interface list off

Apply

OK

Uninstalling the Print Driver software

Start Settings Printers and
Faxes 

Delete

File Server
Properties

Drivers

Remove

Start Run

D:\Utilities\PC Utilities\Driver Extension
●

Creo_Driver_Uninstall.exe
●

Creo_Driver_Uninstall.exe Run as Administrator



Downloading fonts to a Windows-based client workstation
HF_Fontdownloader D:\HotFolders

HF_Fontdownloader

●

●

●

●

Setting up your Macintosh client workstation

Copying the PPD file for Mac OS X

Go Connect to Server

Guest

Connect

Utilities OK

Utilities

PPD

MACOSX CX700_V1.PPD

PPD

Go Computer

Library\Printers\PPDs\Contents\Resources

en.lproj



Europe_A4 US_Letter

CX700_V1.PPD

Setting a virtual printer for Mac OS X- IP, SMB, or Appletalk

PPD

Go Applications

Utilities Printer Setup Utility

Add Printer 

Default Browser  IP Printer

<server_name>_Print

Printer Using Other

CX700_V1.PPD

Open CX700_V1.PPD

Add

Downloading fonts to Mac OS 9
® Chooser

Appleshare

OK

Guest Connect

Utilities OK



Adobe Downloader 5.0.5

 Adobe Downloader 5.0.5

Apple Chooser

LaserWriter (8.x)

Create.

Downloader 5.05

File Download Fonts

Fonts

Disk 0

Download

Installing the Print Driver Software on Macintosh OS X (10.4
or later)

Go Connect to Server

Server Address
Connect

Connect as Guest



Connect

Utilities OK



Mac Utilities

CX700_V1_ColorServerPrintDriverInstaller.dmg



CX700_V1_ColorServerPrintDriverInstaller

Continue



Continue

Continue

Agree



Continue

Install.



OK

Close

Defining a printer with the Print Driver software on a
Macintosh client workstation

●

●

Print & Fax

● Add

● add



Default

● Address

● Queue

● Name

● Print Using Other



Library Printers PPDS Contents Resources
en.lproj Europe_A4 US_Letter

PPD CX700_V1.PPD

Open



Add

PPD



Enabling the Print Driver software on a Macintosh client
workstation

Utility.

Enable Enhanced User Interface On

Server Hostname

Apply.



Uninstalling the Print Driver software

Print & Fax

delete OK

Library Printers Creo_Color_Server_Tools
Creo_Color_Server_Tools

Library Receipts
CX700_V1*.pkg



Printing a file



Print from a Windows client workstation

Printing a job using the Print Driver software

File Print

 Name
<servername>_ProcessPrint

Properties



Imposition Preview

Preview layout with

OK

OK

OK



Print a secure job

Storage locked

Storage

Locking a job

●

●

● Ready

®

File Print

Name

Properties

Print Driver
Finish

Lock



Password
9999

OK

OK

OK

Printing a job using PPD file parameters

● Printer's Default
Printer's Default

●

Color
Color, Print grays using black toner

● Properties Advanced
● Advanced

Document Options Printer Features

OK



Printing a job using hot folders

My Network Places

HF_ProcessPrint

Print from a Macintosh client workstation

Printing a job using the PPD file

®



 File Print

Printer

Copies & Pages Printer Features

Feature Sets



Print

Printing a job using a hot folder

Finder Go  Connect to Server

Connect

Guest Connect

HF_ProcessPrint OK

Printing a file using the Print Driver software (Mac OS X 10.4
or later)

File Print

Special Features
Job Parameters

Print Driver 



Print Driver

●

●

●

●

●

Imposition Preview



Preview layout with

OK

Print Driver OK

Print

Printing from the color server

Importing and printing a job



● PDF

●

●

File Import.

up one level

add

Virtual printer

remove

Import.



Preflight features

●

●

●

●

●

●

●

●

●

●

●

Run preflight 

●

●

●

●



Analyzing a PDF job

PDF Analyzer



PDF PreFlight Settings

● Complete Document
● Pages

Display report automatically

_rep
sample.pdf

sample_rep.pdf

Browse

Run

Performing a preflight check



Services Preflight

Run preflight

Submit



Viewing and printing a preflight report

Preflight report

Print

Save

Preflight Report window

Preflight report



HiRes

Spot Colors



C M Y K

Missing

Found

Fonts

Font Library

Source
Font Library



Exceptions

 Missing

Not preflighted

Found



All

Found Only

All Missing

Unlocking and printing a job
Print Driver

locked

Print Queue
Release to print

Password

OK



Creating a new gradation table

Tools Gradation

Save

Table name

OK

Gradation Table
Color Adjustments



Printing a sample page using the dynamic sample button

Printing a file that contains more than one paper size

Print 

Paper Stock Mixed page size document

Save



Duplex printing using heavy paper stocks

●

●

●

●

❐

❐ Duplex head to toe Duplex head to head
❐ Face up

Manual duplex



Release to print

Both sides
Print



Print

Storage

Print Print method Manual duplex

Aborting a job

Abort

Storage Aborted

Previewing a file or job
Previewing and editing a PDF file

Job Preview&Editor



Previewing and editing an RTP job
Job Preview and Editor overview

Job Preview and Editor window

PagePage

Booklet

Previous
Page

Booklet

Next Page



Pan

Eye Dropper

Zoom In

Zoom Out

One to One
Zoom

Fit to Screen

Percentage

Rotate View

Show/Hide
Separations



Booklet



Thumbnails



Imposed Sheets

Finding the CMYK values of a specific area
Eye Dropper

Eye dropper



Moving a page in a job

Thumbnails

Save As

Deleting a page from a job

Remove

Save As



Merging one or more pages into a job

Thumbnails

Thumbnails



Merge Jobs

OK

●

Merge



Thumbnails

● Merge All

Close

Save As



Calibration



Calibration overview

●

●

●

●

●

●

●

Off-the-glass Calibration

●

●
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●

Printing the off-the-glass calibration chart

File Preferences

Administrator Calibration
and Color

Calibration Device Calibration is done
off-the-glass Save



Tools Calibration

Media Type

Paper Weight

Tray

Auto

Screening

Number of copies

Print

Next



Creating a calibration table using the scanner and printer

Measure

●

●



●

All Services

Network Scanning

Network Scanning calibration

Advanced Settings

Color Space

Device Color Space

Save



● As default name

● Save as

Finish

Creating a calibration table using the
spectrophotometer

●

●

●

●

File Preferences



Administrator Calibration
and Color

Calibration Device Calibration is done using device
tool Save

Tools Calibration



Media Type

Paper Weight

Tray

Auto

Screening

Number of copies

Print



●

Reset
●

OK



● As default name

● Save as

Finish

Mapping jobs to calibration tables

Color Calibration Linked





Managing jobs



Archival and retrieval of jobs

Storage

Archiving a job

Storage
Archive

Archive

Storage



Retrieving a job

File Retrieve from archive

add

Retrieve
Storage 



Forwarding a job to another Creo color server

 Storage

Storage Forward to 
Other 

Host name / IP Address

Find

● Send to Storage Storage

● Send to print Print 

Send

Duplicating jobs

Storage

Storage Duplicate

_dup



Searching jobs

Storage

Storage Search

Deleting a job

Storage
Delete

Yes

Resubmitting a job

Storage
Submit

Copies



Reverting a job to its original file type

Storage Revert to
original file type

Job Reports

Accounting Viewer overview



Accounting Viewer

Title

Job Size

Sender

Job Submission

Started Process

Processing Time

Started Printing



Printing Time

Paper Size

Media Type

Weight

B/W Pages

Color Pages

Blank Pages

Total Pages

Account

Recipient

Job Comments

Exporting the accounting log



Info Accounting

Export

Export

Printing the job report

Storage Job report



Print

OK

OK

Close

Exporting the job report



Storage Job report

Export

File name

Save





Working with color
server tools on client
workstations



EZ Connect utility overview

●

●

●

●

Storage
●

Installing the EZ Connect utility on your client workstation

Start Run

 \\<server_name>

OK

D:Utilites/PC Utilities
EZConnect_v1_0_Setup.exe

EZConnect_v1_0_Setup.exe

OK

Start Programs EZConnect  EZConnect Runner



Adding a color server in the EZ Connect window

Start Programs EZConnect EZConnect
Runner

EZ Connect

EZ Connect

Settings

Setup



New

Hostname/IP
Server_4

Display Name

Type

Connect



Move Up
Move Down

Default Launch Application

Language

Error Status Notification Sign

Save

Renaming a color server in the EZ Connect window

EZ Connect

Settings
Setup



Edit

Display Name

Save

Searching for a job on a color server in the EZ Connect window

EZ Connect

Search

● All Servers
●

●

●

Search



Deleting a color server from the EZ Connect window

EZ Connect

Settings
Setup

Delete

Connecting to the Remote Workspace tool

●

●



●

●

●

●

●

●

Remote Workspace

Default Launch
Application

OK

Finish

Logon



Connecting to the Web Viewer



Storage

Web Viewer

Default Launch
Application

Creo Office hot folders

Installing the Office HF Tool

D:\Utilities\PC Utilities



Office_HF.exe

Creating Creo Office hot folders

Printers



Create HF

Printing Microsoft Office files via Creo office hot folders

®

● .ppt
● .doc
● .xls
● .pub



Creo Color Server Job Ticket software

Overview
Overview of the Creo Color Server Job Ticket software

® JDF

●

●

●

●



Localization

Installation
Installing the Creo Color Server Job Ticket software on
a Windows-based client workstation

D:/Utilities/PC Utilities

CreoColorServerJobTicket.exe

Start Programs Creo Color Server Creo Color Server Job Ticket 

Installing the Creo Color Server Job Ticket software on
a Kodak Prinergy server

® ®

Tools Digital Print
Administration Console Configure

Add

Application Name Creo Color Server JT

Browse

CreoColorServerJobTicket.exe

Add

Done
Digital Print

Administration Console



Tools Digital Print Administration Console
Creo Color Server JT

Creating and managing job tickets
Creating a job ticket on a Windows-based client
workstation

Start Programs Creo Color Server Creo
Color Server JT Creo Color Server Job Ticket V1_0 

Save

Save Template
Save

C:\Program
Files\Color_Server_Client_Tools\Creo_Color_Server_JT\V1_04\JT
files\<server name>



Creating a job ticket via Prinergy

●

●

●

Tools Digital Print
Administration Console Creo Color Server JT

Save

Save Template

Save

C:\Program
Files\Color_Server_Client_Tools\Creo_Color_Server_JT\V1_04\JT
files\<server name>

Opening a job ticket

File Load

Loading job parameters from a selected server

Tools Use JT Settings From



Submitting a job ticket for printing

Submit

Name

Browse

Open

Submit

Printing from the Prinergy software

Pages

Edit Process Template

Include JDF
for Digital Print

Device Selection Creo Spire Color Server
(Xerox®)

PDF Path \\<Creo Color Server name>\<anyshared

folder on the Creo Color Server>

JDF Path \\<Creo Color Server name>\<any hot

folder on the Creo Color Server>



Select JDF Templates Browse

Select <JDF_file_name>

OK

OK

Adding a server

Tools Use JT Settings From Other
Devices

add

Device Name

IP / Host Name

Add.

OK

Removing a server

Remove



Tools Use JT Settings From Other
Devices

Device Name

remove

Yes

OK

Renaming a server

Tools Use JT Settings From Other
Devices

Device Name



Yes

OK

Defining a new location for saved job tickets

Tools Preferences

Save JDF
Location

Save JDF Location Browse

OK

OK

Updates
The update feature

Check for Updates

●

●

●

●



Checking for updates

Help Check for Updates

●

Close

●

Close

VDP Toolbox

VDP Toolbox Overview

●

●

●



VDP Merge

®

VDP View

● Interactive

● Watched Folders Watched
Folder In Out

Watched Folder In

Out

Optimized Mail Merge



● Optimized Mail Merge Mail Merge

● Tools Letters and Mailing 

Getting started
Hardware requirements

●

●

●

Software requirements

●

®

●

●

●

●

Installing the VDP Toolbox

D:/Utilities/PC Utilities



VDPToolbox.exe

Finish

Start
Programs Creo Color server VDP Toolbox

Uninstalling the VDP Toolbox

Start Programs Creo Color server
VDP Toolbox Uninstall



Merging PostScript files into VPS files
Opening VDP Merge

VDP Merge

VDP Merge toolbar



New Job Settings

Open VDP Settings

Open Job Settings

Save Job Settings

Delete Job Settings

Format Manager

Format Manager

Log Viewer

Queue Manager

Manual Operation
Mode

●

●



●

●

●

●

●

●

●

Automatic
Operation Mode

Workflows for Manual mode

●

●



Workflow for Automatic mode

Manual mode

Automatic mode

Automatic mode Format Manager

VDP Generation

● Succeeded
● Failed
● In Process

In Process

Succeeded
Failed

Working with job settings



Creating a job setting

File New Job Settings

Master Description

Size & Orientation 

VDP View 

VDP Generation 

Save Job Settings

VDP Settings name

OK

Opening a job setting

File Open Job Settings



Open

VDP Merge

Deleting a job setting

File Delete Job Settings

Delete

Selecting a variable data file

browse Variable data file



Corporate VDP.prn

Open

Variable data file

Format/Application

●

●

●

●

●

●

Format/Application

Format Manager



Building a booklet

Master Description Insert

corporate
master.prn

.eps tiff
.jpeg .ps .prn

Insert



Add VDP/Blank Page
VDP check box

Add VDP/Blank Page

Remove

Choosing a paper size and orientation

Trim size Custom



H W 
mm inch

H
W

Crop Marks

Trim Size Automatic

Crop Marks
Sheet size A3

H W 
mm inch

H
W

Orientation

Previewing a booklet in the View feature

View

Booklets to proof

All booklets

Optimize for



Optimize for

Preview Now

Generating a Variable Print Specification file

Output folder

browse

Copy master files to target folder 

Use
cache

Range

.vps All booklets
First

Generate VDP



OK

Format Manager



Log Viewer

Open the Log Viewer

Log Viewer
Type

Removing a log entry from the Log Viewer

Remove



Clearing the log

Clear All

Sorting the log entries

Queue Viewer

Moving a job up or down in the queue



Specifying output locations

Output VDP Generation

Tools Output Locations

browse

Add

Deleting an output location

Delete



Specifying hot folder locations

Hot folder VDP Generation

Tools Hot Folder Locations

Browse

Add

Deleting a hot folder location

Delete

Sharing job settings



Specifying common job settings:

Tools Preferences

Value

browse

browse

Open

Value



Apply

OK

Proofing VPS and VIPP Files
Proofing files

In

To proof a VPS or VIPP file:

VDP View 



● VPS file 

Open
VPS file PDF



destination 

●

VPS file PDF destination folder

● VPS file

PDF destination
folder

Optimized for

● Display:

● Press:

● Print:

Range

● All Booklets:

● From/To:

Automatic preview in
Acrobat



Delete PDF file after preview

Start

Results

Automatic preview in Acrobat
PDF

destination 

Abort

Configuring VDP View Settings
Working with Watched Folders

In

Out



Defining Watched Folders

Watched Folders

Settings
Watched

Folders

Add

In Out 

Remove



In Out
Conversion Options Optimized for Range

Policy

● Check watched folders every [number] seconds:

● After PDF is created, original file is:

❐ Moved to “Out” folder: In
Out

❐ Deleted: In

● Delete PDF files older than [number] days:

Out

OK

Watched Folders



Proofing files using Watched Folders

In

●

● Results

● Out 
Watched Folders

Out 

Defining Hi-Res Folders

Defining a Hi-Res Folder

Settings



Hi-Res Folders 

Include sub-folders

Include sub-folders

Continue when Hi-Res file not found

Add



OK

Move Up Move Down

Remove

OK

Hi-Res Folders

Managing the Shared Elements Folder

Settings

Enable



Shared Elements
SoftProof\Intermediate Shared elements

folder

Shared Elements
Browse Shared elements folder 

Shared Elements

● Delete files older than [number] days

●

●  Delete Now.



● OK

Delete Now

OK
Shared Elements

Shared Elements 

Viewing VDP View version information

About

Optimized Mail Merge
Working with Optimized Mail Merge

●

●





Setting up Optimized Mail Merge

Tools Letters and Mailings  Optimized
Mail Merge Preferences

● Variable Print Specification

● Optimized Postscript

Variable Print Specification
Use cached elements

OK

Printing using Optimized Mail Merge

Optimized Mail Merge

All Current record
From To

OK



Name OK

Remote Scan Application

Remote Scan Application overview

●

●

●

●

●

Installing the Remote Scan Application on a Windows client
workstation

Start Run

Open \\

OK

D:\Utilities\PC Utilities

RemoteScan.exe



Installing the Remote Scan application on a Macintosh client
workstation

Go Connect to Server

Server Address
Connect

Guest Connect

Utilities OK

MAC Utilities

RemoteScanInstaller.pkg.zip

RemoteScanInstaller.pkg.zip

RemoteScanInstaller.pkg



Enabling remote scan application connections

File Preferences

Scan Management

Allow ScanBox Manager access control for

● Administrator only
● All users

Enable Remote Scan Application connections



Save

Creating a folder for scanned jobs

Creating a scan box

●

●

Start Programs
creo Remote Scan Application Remote Scan



Server Name or IP

Connect

ScanBox Manager

● SpireBW200_1S
OutputColor=Black and white,

ScanResolution=200dpi, 2SidedOriginal=1 side
● SpireGrayScale200_1S

OutputColor=Greyscale,
ScanResolution=200dpi, 2SidedOriginal=1 side



● SpireColor200_1S
OutputColor=Color, ScanResolution=200dpi,

2SidedOriginal=1 side
● Calibraton

Add 

Scan Box Name

Automatic Copy

Network Path 

●

● Browse Select 

File Type
JPEG

TIFF PDF



Security

Secure Scan Box
Apply

Send to Email

Send to Email

From

To

Subject

Text



● Send scan as link

Settings 
Preferences Scan Delete Scan jobs after

● Send scan as attachment 

Scan Parameters

Output Color

Scan Resolution

2 Sided Original

Save

Close



Viewing a list of scanned images

●

●

Server Name or IP

Connect

ScanBox

Saving scanned jobs to a client workstation

Server Name or IP

Connect

ScanBox

Save as



Save

Deleting scanned images from a scan box

Server Name or IP

Connect

ScanBox

Delete

Deleting all scan jobs from the Public scan box

File Preferences



Scan Management

Delete Now

Save

Auto Update Tool

Installing the Auto Update tool

D:\Utilities\PC Utilities\Support



Color_Server_Auto_Update_installer.exe

Install

Next



Finish
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Introduction
These release notes describe the changes in the Xerox CX Print Server, Powered 
by Creo, for the Xerox 700 Digital Color Press 1.5 software that were made after the 
User Guide was published. 

What Is in These Release Notes
The release notes include the following sections:

• Upgrading the CX Print Server Software describes how to upgrade to version 
1.5 CX print server software.

• New Features describes new menu items, options, windows, or dialog boxes 
that were added to CX print server software.

• Enhancements describes improvements that were made to existing features.

• Limitations lists the limitations for this CX print server release.

• Known Problems lists problems that are not yet resolved.

Printing This Document
Change the paper size to print this document on any printer.

1. Open the PDF file in Adobe® Acrobat®.

2. From the File menu, select Print.

The Print dialog box appears.

3. Select the desired paper size, for example, A4 or letter.

4. In the Page Scaling list, select Fit To Printable Area or Shrink To Printable 
Area.

Note:  The names in the Page Scaling list vary according to the version of the Adobe 
Acrobat software.

5. Click OK.

This document is printed on either A4 or letter size paper.
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Upgrading the CX Print Server Software
Note:  If your CX print server is newly installed, the CX print server 1.5 software is 
pre-loaded and therefore it is not necessary to perform any upgrade procedures.

Before you begin upgrading your software, back up your configuration to a local hard disk, 
network drive, CD or DVD media.

1. From the File menu, select Preferences.

The Preferences window appears.

2. In the Preferences window, select Configuration Backup.

3. In the Configuration backup area, click Browse.

The Save dialog box appears.

4. Locate the desired folder for backup.

5. Enter the file name.

Note:  It is recommended that you use the current date as part of the file name.

6. Click Save.

7. In the Configuration backup area, click Start Backup.

After a few moments, the backup complete message appears.

Note:  The last path is saved and displayed in the path box. If the backup was made to 
external media, the displayed path will be the default: C:\CX700\General\Configuration.

Reinstalling Windows XP
Before reinstalling, ensure that:

• All external USB devices are disconnected from the CX print server.

• The following is available:

� DVD/CD software pack

� Computer name (for example, Mal_WinXP)

� Network information

� Windows XP Professional embedded

� Gateway, WINS address, and DNS information

� Required AppleTalk zone

� IPX information

1. Turn on your computer.

2. Insert DVD 1 (Windows XP Professional Fast Install) into the DVD-RW drive.

Note:  If you are already logged on your system and the CX print server 
workspace is open, quit the workspace, insert DVD 1 into the DVD-RAM drive, 
and proceed to step 3.
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3. Restart your computer.

4. When the CX700 Startup Menu appears, press 1 to perform the complete 
overwrite installation (all data on C and D will be overwritten).

The message Are you sure? appears, click Y.

The system starts copying the files. After about ten minutes, the following 
message appears:
Please remove any DVD media from the drive and press 
CTRL+ALT+DELETE to reboot the computer.

5. When the Windows XP Professional window appears, type the 25-digit product 
key and click Next.

6. In the Computer Name and Administrator Password window, type the name for 
the CX print server, for example Mal_WinXP.

7. Click Next.

The installation process continues.

At the end of the installation, the system restarts. Proceed to Reinstalling the CX 
Print Server Software.

Reinstalling the CX Print Server Software
1. Insert DVD 2 into the DVD-RW drive.

2. In the CX print server software splash screen, click Start.

3. When the License Agreement window opens, click Yes to continue the CX print 
server software installation.

Note:  If the Norton Ghost License Agreement Warning appears, click OK.

Note:  The product key is printed on a label that is stuck to the side of the CX 
print server.

Important:
In the Administrator Name and Password area, use the default settings.

If required, you can change the administrator name and password, but only at 
the end of the installation process. See Xerox CX Print Server, Powered by 
Creo for Xerox 700 Digital Color Press User Guide (731-01341A-EN).
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4. When the installation is complete, remove CD 2 from the DVD-RAM drive.

5. Click Finish to restart the computer.

Note:  For more information about reinstalling the system, refer to Xerox CX Print Server, 
Powered by Creo, for the Xerox 700 Digital Color Press Technical Manual (731-01331A)

Configuring the CX Print Server
After installation you can configure the CX print server.

1. From the File menu, select Preferences.

The Preferences window appears.

2. Select the setting the you need to update and configure the parameters 
according to your site requirements.

Note:  For more information about setting preferences on the CX print server, see 
Xerox CX Print Server, Powered by Creo for Xerox 700 Digital Color Press User Guide 
(731-01341A-EN).

Configuring McAfee VirusScan
After you have installed McAfee VirusScan, perform the following configuration 
procedures. 

Important:  Running McAfee VirusScan could slow down process time and 
affect the overall performance of the server.
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Creo will continue to update their virus protection software recommendations 
according to software performance and market availability.

Once a year, obtain the latest version of the antivirus software and installation 
procedure. The site manager must also regularly download the latest antivirus 
definitions from the relevant Internet site. 

To configure the McAfee VirusScan, perform the following procedure.

Configuring the Scan All Fixed Disks Settings
1. From the taskbar, right-click the VShield icon and select VirusScan Console.

2. In the Task column, right-click Scan All Fixed Disks and select Properties.

3. Click the Detection tab.

4. In the What not to scan area, click Exclusions.

Note:  The following McAfee VirusScan software configuration procedure is 
subject to change without notice, and the relevant documentation may not be 
updated.
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5. Click Add.

6. Click Browse.

7. In the Browse for Folder dialog box, locate the D:\Output folder and click OK.

The D:\Output path appears.

8. Select the Also exclude subfolders check box.

9. In the When to exclude area, select the On read and On write check boxes.
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10. In the Edit Exclusion Item dialog box, click OK.

11. In the Set Exclusions dialog box, click OK, and then click OK again.

Configuring the On-Access Scan Settings
1. Return to the VirusScan Console window.

2. In the Task area, right-click On-Access Scanner and select Properties.

3. On the left of the window, click the All Processes icon.

4. Select the Detection tab.
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5. In the What not to scan area, click Exclusions.

6. In the Set Exclusions dialog box, click Add.

7. Click Browse.

8. In the Browse for Folder window, locate the D:\Output folder and click OK.

The D:\Output path appears.
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9. Select the Also exclude subfolders check box.

10. In the Add Exclusion Item dialog box, click OK.

11. In the Set Exclusions dialog box, click OK.

12. In the VirusScan On-Access Scan Properties window, click OK.

Formatting the Image Disk

Perform the following procedure when suggested as a recovery action.

1. Close all software programs and wait for them to shut down completely.

2. Select Start > CX700 > CX700 Tools > Format Image Disks.

Note:  To format an image disk on the CX print server configuration, you must be 
connected to a Windows-based computer, Mac client, or portable workstation via 
the Remote Desktop Connection. 

Important:  Formatting erases all data stored in the Storage area. It is 
recommended that either an ONSA or your system administrator back up the 
customer’s data, if possible, to an external device or network.



10 CX Print Server 1.5 Release Notes

  

The following message appears.

3. Close all open windows, if required, and click OK.

 

4. Click OK.

The following message appears.

5. Click Yes.

 

6. Click OK.

7. To enable the changes to take effect, restart your computer.
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Removing the Print Driver software
Perform this procedure if you need to upgrade to a later software version of the Print 
Driver software, or if you want to install the Print Driver software for a printer with a 
different name.

1. From the Windows Start menu, select Settings > Printers and Faxes.

2. Right-click the CX print server virtual printer, and select Delete.

The printer is deleted from your client workstation.

3. In the Printers and Faxes window, from the File menu, select Server 
Properties.

4. In the Print Server Properties dialog box, click the Drivers tab.

5. Select the printer and click Remove.

The driver is removed.

6. From the Windows Start menu, select Run.

7. Locate the server.

8. Navigate to D:\Utilities\PC Utilities\Driver Extension.

9. Make sure you close all applications, and then restart your computer.

10. Immediately, perform one of the following steps:

• If you are using Windows XP, double-click DEXUninstaller.exe.

• If you are using Windows Vista, right-click DEXUninstaller.exe, and select 
Run as Administrator.

The Print Driver software is removed.

To reinstall the Print Driver software, see the Xerox CX Print Server, Powered by 
Creo, for the Xerox 700 Digital Color Press User Guide (731-01341A-EN).
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Note:  The Print Driver software version is still 1.0. To verify that the new Print Driver 
software was installed, make sure that:

� A progress bar is displayed the first time you are using the software

� The GBC Punch or the Square Fold Trimmer are available in the Finishing 
tab.
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New Features
This section lists features that were added in the new release of the CX print server 
software.

Finisher Support
You can now chain the High Capacity stacker and the Light Production C finisher.

Square Fold Trimmer
In this version, the Square Fold Trimmer is supported. This optional equipment 
consists of the trimmer, which cuts the faces of booklet sets, and the square folder, 
which flattens the booklet spine, reducing its thickness.

The Square Fold Trimmer workflow includes the following steps:

1. Receives the booklet from the booklet unit of the Light Production C finisher

2. Transports the received booklet to the square folder and then to the trimmer,

3. Outputs the trimmed or square-folded booklets to the booklet tray

You can adjust the trimming position, and change square-fold modes (SquareFold 
Strength setting).
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GBC Punch
GBC Punch is now supported. The GBC Punch is an optional finishing module 
designed to accept a broad range of media weights, sizes, and coatings, and 
provide lead-edge hole punching. 

There are two base units configured to punch letter size and A4 size documents. 
The configurations are similar but differ to accommodate power and edge 
registration.

Sheets that pass through the punch path are limited to letter or A4, and are punched 
as individual sheets along the lead edge. Punch chads are collected in a punch 
container. When the level of chads exceeds a specified level in the container, you 
receive a signal, and the system pauses. 

Each GBC Punch module has two paper paths, punch and bypass. Sheets directed 
through the bypass are passed to one of two connected finishing devices, the High 
Capacity Stacker (HCS) or the Light Production C finisher.
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Off-the-Glass Calibration
In this version, you can select whether or not to print the calibration instructions.

Web-Based Training
The following Web-based training (WBT) material is available on the CX print server 
(Help > Tutorials):

• Imposition Template Builder WBT: Describes how to prepare various imposition 
templates using the Imposition Template Builder 

• CX Print Server WBT: Describes CX print server workspace, Job Parameters 
window, and basic workflows 

Chinese Support
In this version, the CX print server software is translated to Chinese. 

For more information about how to change the language options to Chinese, see 
Enabling Chinese Characters for the Xerox CX Print Server, Powered by Creo, for 
the Xerox 700 Digital Color Press Technical Bulletin (734-00944A-EN).
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PDF Library 9.0
The CX print server now supports Adobe® PDF Library 9. This is the latest version 
of the PDF library, and it provides improved printing of transparencies and better 
image quality.

ISO Coated v2 Source Profile
The CX print server now includes the ECI offset profile ISO Coated v2. This is a 
good choice in cases where the intended printing condition is not yet known. 
Prepress data prepared with this profile can be converted to many other printing 
conditions with good results, however, the best possible results will be achieved with 
CMYK prepress data prepared with the profile that matches that printing condition 
exactly. 
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Enhancements
This section lists features that were improved in this release of the CX Print Server 
software. 

Imposition

Step-and-Repeat Method
In this version, when you select the step-and-repeat imposition method, you can 
specify the number of copies to print, either per sheet or per page. 

For example, if you place four business cards on one sheet, and set the number of 
copies to 100 sheets, 400 business cards will be printed (100 sheets). If the number 
of copies is set to 100 pages, 100 business cards will be printed (25 sheets).

Sheet

Page
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Scaling
For imposed jobs, if you select the Do not affect imposition marks check box, crop 
marks and fold marks are not affected by scaling. This enables you to use the crop 
marks as a bleed option. 

This example shows the differences between the options.

Note:  This check box is available only when the scaling value is greater than or less than 
100%.

Original imageJob is scaled 105% and 
crop marks are also scaled.

Job is scaled 105%, but 
crop marks are not scaled. 
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Limitations
This section lists limitations in the CX print server software.

High Capacity Stacker (HCS) Unlock Button 
You can only release the HCS stacker tray after a job finishes printing.

Using the HCS Dynamic Sample Button
Only use the HCS Dynamic sample button for jobs in which you will print more than 
one copy.

Calibration
The option to calibrate via the Web UI was removed and is not supported.

Job Forwarding
Make sure the user name and password of the server you forward a job from has the 
same user name and password as the server you forward the job to.

Stapling Jobs
To staple a job, make sure that the following job parameters are set according to the 
image orientation and feed orientation of your job: 

• Finishing > Print Order (Face up or Face down)

• Print > Layout > Rotate 180

• Finishing > Stapler (front, center, rear, or dual)

Remote Scan Application
On some client workstations, the Remote Scan Application doesn’t work if the 
system fonts aren’t in English.
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Print Driver Software
When you set the Print Driver software to display American measurements, A4 
paper is the default setting instead of letter size paper. 
Workaround: On your desktop, go to Start > Settings > Printer and Faxes, and set 
the desired destination printer as your default printer.

Importing JPG Files
The CX print server only supports baseline compression of .jpg files and not 
progressive compression. 

Mixed Paper Size Jobs
You can’t include an Admin page, front cover or back cover in jobs that include 
mixed paper sizes and different paper feed orientations.

Printing From Tray 5
• If you want to print a job from Tray 5, make sure you select this tray in the Job 

Parameters window (Print > Tray).

• If the printer is in sleep mode, Tray 5 appears empty in the Trays area of the CX 
print server workspace.
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Known Problems
This section lists known problems in the CX print server software.

Scanning Templates
If you have reinstalled the CX print server software, and there is no network cable 
connected to the CX print server, or the network doesn’t have a DHCP server, there 
may be a eight minute delay from the time the test page is printed until you can 
access the Network Scanning Templates and Web Applications on the Xerox 700 
digital color press user interface.

Printing Microsoft PowerPoint Files 
To print Microsoft Powerpoint® files on large paper sizes using the Print Driver 
software, select the paper size in the Original Page Setup list. 

Connection Failures
If you need to turn off the printer—for example, due to a fault, make sure you first 
abort any jobs that are printing. Otherwise, the CX print server won’t reconnect to the 
printer.

Changing Printer Settings
If you change printer settings that require you to restart the printer, make sure you 
restart both the printer and the CX print server, otherwise the status of the printer 
won’t be displayed in the workspace.
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